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CHAPTER 4

Compose an Animated 
HTML5 Greeting
This chapter will build on everything you’ve learned so far, but we’ll take 

things in a different direction from previous projects by authoring content 

that runs natively in the browser without the need for Flash Player. We’ll 

also delve deeper into aspects of the library and symbols while introduc-

ing some new tools.

This project involves the traditional web-based greeting card (Figure 4.1), 

but with a twist: the client wants you to design the card in such a way that 

it can be accessed via a web browser on a desktop, mobile device, or 

other similar means. In other words, since the browser-based Flash Player 

is widely available only on desktop browsers, in order to hit mobile tar-

gets we’ll need to deploy using a native HTML5 target. Luckily, Adobe 

Animate CC includes a number of target-platform document types suited 

specifically to this task.

	Video 4.1  Project 
Overview
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Creating a New HTML5 
Canvas Document
Content created in Animate CC can be published directly to a number of modern 

HTML5 formats, including Canvas and WebGL. The primary document type that 

allows this publish target is HTML5 Canvas. When creating content using this 

publish target, Animate CC leverages the CreateJS JavaScript libraries to output an 

entire animation or interactive project for the HTML5 canvas element.

Setting up the project document
The first thing you’ll do is create a new document by doing one of the following: 

�� On the Welcome screen, select HTML5 Canvas as your document type.

�� Choose File > New to open the New Document dialog box (Figure 4.2). In the 

Type list, select HTML5 Canvas.

NOTE  
The HTML5 canvas element is also used to display WebGL content.

Figure 4.1  The greet-
ing you’ll create in this 
chapter

  ACA Objective 1.4

  ACA Objective 2.1

	Video 4.2  Creating 
a New HTML5 
Canvas Document
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CREATEJS

CreateJS is a suite of modular JavaScript libraries and tools that work 
together or independently to enable rich interactive content using open web 
technologies in HTML5. See www.createjs.com to learn more.

Animate CC opens a new document, which initially looks exactly the same as the 

documents we’ve already worked with. You should note a number of differences, 

however:

�� First, notice that in the General tab of the New Document dialog box, the 

name of the file is appended with the (Canvas) qualifier. This lets you know 

that you’re working in that particular document type. ActionScript-based 

projects have no such qualifier.

�� A couple of tools in the Tools panel are disabled: the 3D Rotation tool (   ) 

and the 3D Translation tool (   ).

�� If you select the Text tool (   ), you’ll notice that you can only choose Static 

Text or Dynamic Text. Input text Type is disabled.

�� When viewing Document Properties, you’ll see that a lot of options under 

the Publish area are disabled because they pertain only to ActionScript-based 

projects.

Figure 4.2  The New 
Document dialog box

NOTE  
The HTML5 canvas 
element is a structure 
through which bitmap 
data can be drawn 
and changed via Java­
Script. It also includes 
the ability to process 
and respond to various 
modes of interactivity 
like mouse clicks and 
touch events.
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Otherwise, creating and animating content targeting HTML5 Canvas should be 

nearly identical to what you have already encountered.

Preparing the Stage and timeline
Before creating any assets in the greeting card project, you’ll do some work on con-

figuring the Stage and other project fundamentals.

1	 In the Properties panel (Figure 4.3), set the Stage width to 550 pixels and the 

height to 400 pixels. This is the normal Animate CC default, so there may not 

be anything to change depending on your preferences.

	

Figure 4.3  Configuring the 
Stage in the Properties panel

2	 Make sure FPS is set to a value of 24 and choose a background color that suits 

you. I choose black most of the time, but in this project, I’ll select a cheery 

orange color instead. You’ll be drawing a background anyhow, so it doesn’t 

matter all that much.

3	 Moving on to the timeline, rename the present layer BG. This is where you 

will draw your project background.

4	 Use the New Layer button (   ) to create an additional layer and name it 

Frame (Figure 4.4). This layer will contain assets that make up the basic back-

ground elements of your project.

	

Figure 4.4  Frame layer 
added
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5	 Save the document in a location that makes sense to you.

Even though you’re using a different document type in this project, 

Animate CC treats the file the same way, even saving it in the same FLA 

file format.

Laying Out the 
Background Elements
Now that you have layers for your frame and background assets, you can create 

these elements using the shape and drawing tools in Animate CC. You’ll be using 

some of the vector tools you’re already familiar with, but you’ll also be introduced 

to the concept of variable-width strokes and the super cool Paint Brush tool.

Drawing the background
To draw the background to the greeting card project, you’ll use the new Brush 

Library and the Paint Brush tool in Animate CC.

1	 To begin, lock the Frame layer to ensure that you don’t draw anything in it 

by mistake.

2	 Select the BG layer within the timeline and select either the Rectangle  

tool (   ) with Object Drawing Mode enabled or the Rectangle  

Primitive tool (   ).

You’re now ready to draw the background.

3	 Drag from the top left of the Stage to the bot-

tom right to draw a shape exactly the same 

size as the Stage: 550x400.

4	 You may need to make some adjustments to 

the size and position of your shape, depending 

on your snap settings and how steady a hand 

you have. Do this from the Properties panel 

with the object selected.

5	 If you haven’t done so already, choose a 

background color for your shape. I’m using 

#FF9933 in the example shown in Figure 4.5, 

but you can choose whatever you like.

  ACA Objective 4.1

	Video 4.3  Drawing 
the Background

Figure 4.5  I’m using an orange-ish background for my shape.
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6	 You don’t need any stroke color for this project, so choose None 

for the Stroke color. It’s represented in the color picker as the white 

block with the red diagonal line running through it (Figure 4.6).

NOTE  
You can always turn off stroke or fill by choosing None for either 
color value.

Figure 4.7  The Properties panel with 
the Paint Brush tool selected

1	 To begin, select the Paint Brush tool from the Tools panel. The 

Paint Brush tool Properties panel opens (Figure 4.7). You’ll be 

drawing these decorative assets in the BG layer.

2	 Choose Window > Brush Library to open the Brush Library.

In the Brush Library, you’ll see a number of categories, which 

contain a wide variety of prebuilt vector art brushes.

3	 Find one you’d like to use and select it.

It should now show up in the Style area of your Properties panel. 

You can see in Figure 4.8 that I’ve chosen the brush named Chalk - 

Scribble from the Artistic > Chalk Charcoal category in the Brush 

Library.

Now it’s time to get creative!

	

Figure 4.8  The Brush 
Library

Figure 4.6  No stroke color as repre-
sented in the Properties panel

Decorating with the Paint Brush tool
Now for some freeform fun! The Paint Brush tool (   ) lets you draw out strokes 

with vector art attached to them. This allows for massive creative possibilities, 

whether you’re using built-in brushes from the Brush Library or using custom 

brushes you created with the Adobe Capture CC mobile app and shared with 

Animate CC via the CC Libraries panel.

	Video 4.4   
Decorating with  
Art Brushes
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4	 Using the Paint Brush tool, drag across the Stage to generate freeform vector 

artwork. Don’t make your art too busy, but don’t hold back too much either. 

Make it interesting.

TIP  
You may want to select the Draw As Fill option in the Paint Brush Options 
section of the Properties panel. This will draw out vector art as fill and not 
strokes. Selecting Draw As Fill will generally be more performant on slower 
systems since a good part of the rendering is already completed and the 
appearance does not need to be generated on-the-fly as with stroke-only.

5	 Select a Shape color. In Figure 4.9, I’ve chosen to use something a few steps 

darker than my background (#A35A12), but there’s no reason you couldn’t 

use a number of variations in color or even stroke width. You can control all 

these properties from the Properties panel with the Paint Brush tool selected.

	

Figure 4.9  An artistic 
background

6	 Once you’re happy with the results, lock the BG layer and unlock the Frame 

layer for the next step in this project.

EDITING AND MANAGING VECTOR ART BRUSHES

You can also edit existing brushes by clicking the Edit Stroke Style icon (   ) 
in the Properties panel with the Paint Brush Tool selected. This allows even 
greater variation in how the vector art is mapped to your strokes.

It is also possible to use the Paint Brush Options dialog box to convert 
vector art brushes into pattern brushes (and vice versa). Pattern brushes are 
great for things like frames and borders. 

To manage all the brushes within your document—or even save custom 
brushes to your Brush Library—click the Manage Paint Brushes button in the 
Properties panel with the Paint Brush tool selected. 

NOTE  
You can also access the 
Brush Library directly 
from the Properties 
panel by clicking the 
Brush Library icon  
(   ).
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Drawing the frame with variable-width strokes
Using variable-width strokes in your project is an easy way to impart a bit of con-

trolled chaos to simple strokes. Animate CC will, in place of a linear stroke, impart 

a stroke whose width varies at certain points. The best way to grasp the concept is 

to use it. You’ll create a nice frame for this project and apply a variable-width pro-

file to the frame stroke.

1	 Select the Frame layer so that you can draw the object. You may want to 

ensure all other layers are locked before proceeding.

2	 Choose the Rectangle or Rectangle Primitive tool and draw a vector object the 

exact size of your Stage: 550px by 400px. Use whatever color you like for the 

stroke (in Figure 4.10, I’m using #336600), and choose a transparent fill.

3	 With the object selected, choose a profile from the Width menu in the Fill 

And Stroke section of the Properties panel. If something doesn’t look right, 

select the Width tool from the Tools panel and tweak existing width points or 

even create new ones.

  ACA Objective 2.6

  ACA Objective 4.5

	Video 4.5  Making 
a Frame

4	 For an additional creative flourish, apply a vector art brush to the 

variable-width stroke as well. In Figure 4.11, I’m using Artistic > 

Chalk Charcoal > Chalk - Round from the Brush Library and a 

stroke value of 26.

Figure 4.10  Drawing Object Properties

Figure 4.11  A little extra creative flourish added 
with a vector art brush
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GROUPING THE LAYERS WITHIN A FOLDER

One of the best things you can do to keep things organized in your timeline is to 

group layers. You can accomplish this by creating a layer folder for specific sets 

of layers.

1	 Click the New Folder button below the layer stack on the bottom left of the 

timeline to create a folder to contain your static background elements.

2	 Double-click the folder name and change it to Background.

3	 Drag both the BG and Frame layers into the layer folder you just created 

(Figure 4.12).

	

Figure 4.12  BG and 
Frame layers added to 
the new layer folder

With the folder created, you can now control the lock status, visibility, and out-

line mode for all layers from the folder itself. You can also collapse and expand the 

folder by using the small triangle beside the folder icon.

Drawing the Flowerpot
Now that you’ve defined the static background elements for your greeting, you  

can begin work on the more complex, animated objects.

Creating and modifying a vector  
rectangle shape
You’ll begin by drawing a simple flowerpot.

1	 Create a new layer and name it Flower.

2	 With this layer selected, select the Rectangle tool (   ). Don’t select the 

Rectangle Primitive tool because in order for the shape to appear similar to 

the form of a flowerpot, you’ll need to manipulate the shape.

  ACA Objective 3.1

	Video 4.6   
Grouping Layers

	Video 4.7  Drawing 
the Flowerpot
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3	 Draw a square about 120px by 120px. It doesn’t have to be exact, and the 

color choices don’t matter at this point. You don’t have to include any stroke 

for this square.

4	 Select the Selection tool (   ).

5	 With nothing selected, hover the cursor along the top edge of your rectangle 

shape. Notice how the cursor changes to include a small arc. This indicates 

that you can bend the paths that define your shape by pulling and pushing 

the edges.

6	 Pull down slightly on the top of the square to form a nice dip (Figure 4.13). 

This is the top of your flowerpot.

	

Figure 4.13  Manipulating 
the shape

7	 You need to create the inside of the flowerpot as well. Select the Oval tool  

(   ), activate Object Drawing Mode (   ), and draw an oval 

that matches the arc and size of the flowerpot top. The color you use should 

be a dark brown (#4B2500) since this portion of the flowerpot will be in 

shadow. Don’t apply any stroke to this object.

8	 Using the Subselection tool (   ), select the bottom-left anchor point of 

your shape.

9	 With the point selected, use the arrow keys on your keyboard to nudge the 

point over a few pixels, creating a taper in your flowerpot. Perform a similar 

action on the other side.

10	To finish the flowerpot shape, select the Selection tool again and pull down 

the bottom of the shape slightly to give a little more perspective to the flower-

pot, very similar to the modification you made to the top (Figure 4.14).

TIP  
Selecting Object Drawing Mode will ensure that overlapping shapes do not 
merge and cut into one another destructively.

	Video 4.8   
Shaping with the 
Selection Tool

Figure 4.14  Choose a 
dark brown for the inside 
of the flowerpot.
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Applying colors and gradients
Gradients in Animate CC always start as either centered radial gradients or hori-

zontal linear gradients. You use the Gradient Transform tool (   ) to recenter, 

rotate, or stretch a gradient. It’s very similar to the Free Transform tool, but it 

affects only how the gradient is displayed. Access the Gradient Transform tool by 

clicking and holding the Free Transform tool icon (   ) in the Tools panel.

1	 Use the Selection tool to select the flowerpot shape.

2	 Open the Swatches panel and choose Linear Gradient from 

the color type menu.

By default, you’ll see a gradient that runs from pure white 

to complete black.

3	 Change this to run from a slightly lighter brown (#824000) 

to a slightly darker brown (#582C00) (Figure 4.15). 

Gradients often look best when there’s a subtle change 

across the gradient.

If you want to preserve this color definition as a reusable swatch, 

click the Add To Swatches button to make it selectable from 

any Swatches panel within Animate CC. You can now select the 

flowerpot shape and easily apply the recently created swatch to 

the fill by using the color picker in the Properties panel.

Now that the gradient swatch is applied, you can use the Gradient Transform tool 

to adjust how the linear gradient appears on the flowerpot shape. When an object 

with a gradient applied is selected using this tool, you can adjust the rotation, cen-

ter point, width, and more.

ABOUT TAGGED SWATCHES

A recent addition to Animate CC is the concept of tagged swatches. This 
allows you to choose a swatch from the Swatches panel and transform it 
into a tagged swatch by clicking the Convert To A Tagged Swatch icon (   ) 
below the swatches grid. Tagged swatches differ from other swatches in that 
a small white tag appears in the lower right of a tagged swatch.

When you have a number of shapes using the tagged swatch, you can easily 
update the swatch and the changes will automatically cascade across all 
objects using that tagged swatch.

  ACA Objective 2.5

	Video 4.9  Using 
Gradients

Figure 4.15  The settings you choose in the 
Color dialog box should match the ones 
shown here.
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Convert to a graphic symbol
Symbols, at their most basic level, serve as containers for artwork. They come in 

three varieties, each with unique characteristics that allow them to be used for 

animation and interaction. Keep in mind that although Animate CC refers to 

“converting” elements to symbols, you’re really wrapping the existing elements into 

symbols. Using symbols will allow nearly any graphical element to become a but-

ton, be animated in specific ways, or even be manipulated by code.

Creating a symbol from an existing set of elements is fairly simple. Here’s how.

1	 Select everything on the Flower layer of the timeline and choose Modify > 

Convert To Symbol.

Once the Convert To Symbol dialog box appears, you’ll be given the option to 

type in a name for the symbol, select the symbol type, and specify a registra-

tion point alignment (Figure 4.16). There’s also an area to access advanced 

options that are used primarily for linkage as a class within ActionScript.

	

Figure 4.16  The Convert To 
Symbol dialog box

2	 Name the new symbol Flower and choose Graphic from the Type selection 

box. Click OK.

Once you click OK, the symbol is created and stored within the project 

library. Additionally, an instance of that symbol remains on the Stage, exactly 

where the conversion occurred.

Types of symbols within Animate CC
You can create three different types of symbols within an Animate CC project: 

movie clip, graphic, and button. In this project, you’ve created a graphic symbol. 

The choice of which symbol type to use isn’t always clear, but learning more about 

each of these symbol types can help you choose the one that will work in your 

interactive media application.

  ACA Objective 2.4

	Video 4.10   
Creating a  
Graphic Symbol

TIP  
It’s a good practice 
to always name your 
symbols with no spaces 
and no special char­
acters and beginning 
with an uppercase let­
ter. This has to do with 
how Animate CC views 
symbols, and it will sim­
plify the process as you 
explore more advanced 
topics.
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MOVIE CLIP SYMBOLS

A movie clip symbol has a timeline that behaves like—but is completely inde-

pendent of—the main Stage and is the primary symbol used when creating cus-

tom functionality within Animate CC. We’ll see this use of movie clip symbols in 

greater detail during the later chapters. Movie clip symbols can be controlled with 

ActionScript or JavaScript as well as through timeline manipulation, making them 

extremely useful for customizing an interface.

GRAPHIC SYMBOLS

Graphic symbols are fairly simple to create, and the operation of the symbol time-

line is exactly the same as that of the main timeline. The main purpose of the 

graphic symbol is to create reusable graphical elements and simple animations in 

an efficient package.

BUTTON SYMBOLS

Button symbols provide you with a quick and relatively simple way to create a stan-

dard interactive media button. These buttons can be created out of nearly any type 

of artwork, including other symbol instances, and can support a static or normal 

state, a rollover state, a down state, and a hit state. You construct the artwork for 

these states using keyframes, but rather than relying on frame numbers, the inter-

face for construction of a button symbol uses Up, Over, Down, and Hit to identify 

where the keyframes for these states should be placed (Figure 4.17). We’ll see this 

in detail as we work through the project in Chapter 8.

Figure 4.17  The button 
symbol timeline

The hit state for a button symbol is not visible, but the artwork in the keyframe 

defines the clickable area of the button symbol. If a button symbol has no hit state, 

the current keyframe artwork is used to determine the clickable or live area of 

the button.

NOTE  
If a button symbol has only a hit state, it is an invisible button that will show 
up in light blue during authortime but will be invisible at runtime.

Chapter 4  Compose an Animated HTML5 Greeting  101

Sam
ple

 p
ag

es



Editing the Flower Graphic Symbol
Symbols provide Animate CC projects with reusable elements that can be placed on 

the Stage as instances multiple times without recreating artwork. This approach can 

drastically reduce file sizes and can also simplify editing a layout by minimizing the 

number of graphic elements required to produce an interactive media project.

Explaining symbols and instances
When a symbol is created, it resides in the project library. The symbol acts as a blue-

print to instruct Animate CC on how to construct an instance of that symbol.

Instances are representations of the symbol that exist on the Stage and timeline. 

When you drag a symbol from the Library panel to the Stage, you’re creating an 

instance of that symbol. You can have multiple instances of a single symbol on the 

Stage (Figure 4.18). If you edit the symbol, all the instances will change as well.

This feature can be effective for making changes globally in an Animate CC project. 

However, it can also be frustrating if you want each instance to be slightly different.

  ACA Objective 2.4

	Video 4.11   
Editing Symbols 
and Symbol 
Instances

Figure 4.18  You can 
have multiple instances of 
a symbol on the Stage.
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Fortunately, symbol instances can be more than exact copies of the original sym-

bol definition in the Library panel. You can modify the individual properties of 

each instance using the Properties panel or tools such as the Transformation tool. 

These property changes affect only the selected instance, not the original symbol 

definition.

Embedding additional symbols and elements within a symbol definition can also 

provide a means of customizing each instance using code. A common application 

is to include a dynamic text field within a symbol definition. With some simple 

programming, you can alter the content of this text field at the instance level. The 

nesting can get a bit complicated, but having only a single element in the library 

can make it worth the trouble if you ever need to make global changes.

Differences between movie clip 
symbols and graphic symbols
Movie clip and graphic symbols look very similar in the Animate CC authoring 

environment, but big differences between them exist. The first has to do with the 

synchronization between the symbol timeline and the main movie timeline.

A graphic symbol is linked to the main timeline, whereas a movie clip 

symbol is an independent object whose timeline runs independently 

of the main timeline. If the main timeline is changing frames, so is 

the graphic symbol. If the main timeline is paused, the graphic symbol 

(which is linked frame by frame) is paused too. The movie clip timeline 

isn’t bound to the main timeline and runs completely independently.

Another difference involves the use of ActionScript and JavaScript. 

Using code, you can access and control movie clip instances through 

the instance name assigned in the Properties panel. The graphic sym-

bol has no option to assign an instance name and is not accessible via 

code as an object (Figure 4.19).

A performance difference exists as well. Graphic symbols require less 

processing. Even with this advantage, many interactive media develop-

ers make nearly every object a movie clip, just to increase the flexibility 

of the use of the object, though animators often prefer graphic symbols 

for the ability to specify the presented frame being shown at any time 

via the Properties panel.

Figure 4.19  The Properties panel with 
a graphic symbol instance selected
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Editing the flower symbol
You can edit symbols by double-clicking any instance of the symbol on the Stage or 

double-clicking the symbol within the Library panel.

1	 Double-click the symbol instance you created to edit it in place. 

When the symbol opens, notice that a breadcrumb trail showing the hier-

archy of the object shows up in the top-left corner of the Stage. You can 

leave the editing mode by clicking the scene name in this breadcrumb trail 

(Figure 4.20).

	

Now that you’re operating within the symbol, notice that the symbol itself 

has its own timeline. In an Animate document, each symbol, no mat-

ter the type, has its own timeline. This allows for a great range of creative 

possibilities.

The next thing you’ll do is to manage this internal timeline a bit better. 

Because you already have a number of objects within this symbol, you can 

place each of them on its own layer.

2	 Select all the objects on the Stage either by dragging a selection rectangle 

around them with the Selection tool or by giving the Stage focus and using 

the Select All shortcut, Cmd+A (macOS) or Ctrl+A (Windows).

NOTE  
It doesn’t matter if you double-click the symbol within the Library panel or 
use the edit-in-place option of double-clicking an instance on the Stage. 
You’re still editing the base symbol—not the individual instance. This means 
that any changes you make will be made to all instances of that symbol. 
This doesn’t matter much in this case, since you’ll be using only one 
instance of this symbol.

	Video 4.12   
Preparing the 
Symbol

Figure 4.20  Clicking 
Scene 1 in the bread-
crumb trail will return you 
to the main timeline.
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3	 With all of your elements selected, right-click them 

and choose Distribute To Layers from the menu 

(Figure 4.21).

This takes each object and creates a new layer for it and 

then empties the previous layer of all selected content. 

The original layer is empty, as indicated by a blank 

keyframe.

4	 Delete the original, now empty layer, by selecting it and 

clicking the Delete Layer icon (   ) beneath the layer 

stack in the timeline.

Both the flowerpot shape and the darker, inner pot 

shape should now be on separate layers.

5	 Rename the main pot shape pot, and rename the layer representing the inner, 

backside of the flowerpot potback.

6	 Ensure the topmost layer is pot and that potback is directly beneath it. Lock 

these layers before moving on.

Drawing a flower stalk
For the stalk of the flower, you’ll create a simple shape with the Brush tool (   ) so 

that it isn’t completely straight and appears a bit more natural. The Brush tool is a 

freeform tool that draws shapes composed of fill alone.

1	 Create a new layer and name it stalk.

2	 Place this layer between the pot and potback layers by dragging the new layer 

into position (Figure 4.22). Now the order from top to bottom should be pot, 

stalk, and potback.

	

Figure 4.22  Place the  
Stalk layer in the middle  
of the layer stack.

3	 Select the Brush tool (   ) and look at the Properties panel.

	Video 4.13   
Drawing the Stalk

Figure 4.21  Choosing Distribute To Layers
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4	 Choose a nice green color (#32CC32) for your fill and look to the Brush Shape 

area of the panel to see the brush size and shape options. Select a round brush 

and bump the size way up to a value of 14 or so for a thick stalk.

5	 Keep Object Drawing Mode off for now. Since we are drawing the stalk shapes 

on their own layer, we do not need to worry about interaction with the 

other elements.

6	 Draw the primary stalk beginning behind the shape on the pot layer and 

extending up. If you like, you can draw a straight shape by holding down the 

Shift key as you draw, though it may look more natural if you freehand it. You 

may wish to adjust the Smoothing value to assist in getting the desired look—

a value of 75 works pretty well for this. The stalk, when complete, should 

measure about 230px in height (Figure 4.23).

	

Figure 4.23  Set stalk 
parameters in the 
Properties panel.

Before moving on, we need to define some secondary stalks on either side of the 

primary stalk that was just drawn. 

1	 Select the Brush tool again and reduce the Size value to 10. 

2	 Move down a third of the way from the top and draw out a stalk emerging 

from the left side.

3	 Go another third down and draw another stalk emerging from the right. 

You will now have drawn a long, primary stalk for the flower, which includes two 

branching stalks on either side (Figure 4.24). Don’t worry if things look unnatu-

ral at this point; we’ll be able to pose all of the stalk elements more naturally with 

inverse kinematics!
Figure 4.24  The fully 
realized stalk shape

106  Learn Adobe Animate CC for Multiplatform Animations

Sam
ple

 p
ag

es



Animating the Flower Stalk 
with Inverse Kinematics
Inverse kinematics allows you to animate objects in Animate CC using a series of 

bones chained into linear or branched armatures in parent-child relationships. This 

means that when one bone moves during an animation, that connected bones will 

also move in relation to it. Inverse kinematics is a unique way of animating content 

to create natural motion.

To animate using inverse kinematics, specify the start and end positions of bones 

on the timeline. These positions are known as “poses” in Animate CC. The arma-

ture will be automatically adjusted to tween positions of the bones in the armature 

between poses (Figure 4.25).

You can apply inverse kinematics within Animate CC in one of two ways: by 

drawing bones within a single shape or through the construction of an armature 

composed of multiple movie clip symbol instances. In this project, you’ll create a 

shape-based armature from the flower stalk you just created.

  ACA Objective 4.4

Figure 4.25  Animating an 
armature using inverse  
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Animating the flower stalk 
using an armature layer
Your next step is to animate the stalk growing up and out of the flowerpot. To do 

this, you’ll take advantage of the armature you’ve already created. You don’t need 

to specify any sort of tween when working with armatures; Animate CC will handle 

all of this automatically once different poses are defined.

1	 First, you’ll need to extend your frame span to the 6-second marker. To do 

so, move the playhead to frame 144, select the frames across all layers, and 

choose Insert > Timeline > Frame. 

These frames will provide enough time to nicely animate the growth of your 

stalk and will allow for some automated “springiness” once the animation has 

concluded. Bring the playhead back to frame 1 when finished.

2	 Select the Bone tool (   ) from the Tools panel. You’ll use this tool to define 

the bones within your armature. 

3	 To define a bone, drag a short way from the bottom of the stalk to the first 

branching stalk (Figure 4.26). You will draw subsequent bones across the 

shape by pressing the mouse button over the end point of the previous bone 

and dragging out a new segment. 

	

Figure 4.26  Defining the 
initial bone

	Video 4.14  Using 
the Bone Tool

TIP  
When drawing bone 
segments, you’ll find 
it helpful to disable 
all snapping and also 
zoom the stage for 
more precise place­
ment. You can also turn 
off the visibility for lay­
ers that may obstruct 
your view.
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4	 Draw about three or four bone segments along the central stalk to the top. Try 

to have each joint (the juncture between each bone) aligned with one of the 

secondary stalk elements.

5	 We will now branch our armature out across the secondary stalk segments. 

For each joint closest to a secondary segment, pull out more bones to define 

those segments as part of the armature. Each secondary stalk segment should 

have about three bones apiece (Figure 4.27). The reason for creating many 

bones is to increase flexibility and refine the range of motion.

Notice how the stalk layer is now empty? A new layer named Armature_1 now 

exists above it with the frames colored light green, and the icon is a small figure. 

These changes indicate that this is a new armature layer (Figure 4.28).

Figure 4.28  The light 
green layer color indicates 
an armature layer.

Because you’re using an armature, all you need to do to modify your pose is to drag 

with the Selection tool. Try it out! Notice how everything naturally moves in rela-

tion to any portion of the stalk you click and drag? This is the power of inverse 

kinematics.

Once an armature is assembled, it has a default pose. When you modify a property 

on any particular frame, it’s called a pose. Poses can be copied for easy modifica-

tion and reuse. You want your ending frame to contain a pose with the stalk fully 

extended.

1	 Let’s go ahead and delete the existing stalk layer—it is no longer needed. 

Rename the armature layer to stalk, for clarity.

2	 Select frame 48 (the 2-second marker) on the armature layer and right-click. 

Choose Insert Pose from the menu to duplicate the pose from frame 1. The 

flower stalk will remain completely opened within this second pose.

3	 Return to frame 1 and use the Selection tool to modify the initial pose so that 

the secondary stalk segments are much closer to the main stalk. They will 

spread out as the main stalk becomes taller. 

4	 Now, pull the main stalk slightly to the side in order to introduce further dif-

ferentiation between poses (Figure 4.29). 

	Video 4.15   
Managing  
Armature Poses

Figure 4.27  The com-
pleted armature extends 
across all stalk segments.

Figure 4.29  The pose for 
the emerging stalk
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5	 Use the Selection tool to select the entire plant.

6	 Use the arrow keys to reposition the entire stalk down into the flower pot a 

bit. It’s fine to have most of it sticking out, but we want to give the illusion of 

growth and this will help (Figure 4.30). 

If you preview the animation between frames 1 and 48, you’ll see that Animate CC 

performs a special armature tween between these two poses. The stalk begins with 

its branches very close to the main stalk and is seated low in the pot. The secondary 

stalk branches spread outward as the primary stalk appears to grow taller. 

This is nice…but working with inverse kinematics allows us to add in a bit of 

dynamic animation as well—by applying values of Strength and Damping to each 

bone segment’s Spring property. We have allowed a few extra seconds in the time-

line beyond the 2-second mark for this very purpose.

TIP  
You can also use inverse kinematics to construct an armature out of multiple 
movie clip instances. This is useful when building an armature for a human 
form or something mechanical in nature. Shape-based armatures are more 
suited to plants with long swaying stalks or creatures like snakes.

Adding Spring to the armature animation
The stalk animation runs for only two seconds at the moment, but by adjusting the 

Spring properties for various bones, we are able to dynamically generate additional, 

subtle movements based on inverse kinematics.

	Video 4.16   
Applying Spring  
to Your Bones

Figure 4.30  The com-
pleted pose for the initial 
stalk

1	 Zoom in about 200 percent so that it is 

easy to manipulate the armature.  

We’ll focus on one of the secondary stalk 

segments for now.

2	 Each secondary segment should have three 

bones defined across its length. Using the 

Selection tool, click the bone that is far-

thest from the main stalk. The bone is now 

selected and appears highlighted.

3	 In the Properties panel, in the Spring sec-

tion set Strength to 90 and Damping to 2 

(Figure 4.31). 

	Figure 4.31  Stalk bones farthest from the main stalk should be 
very springy.
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